
True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

1. A Lookup field lets you select a value from a list instead of keying the 
value.

2. When you clear the Relationships window, you also delete the 
relationships.

3. The set of database rules for relationships is known as validating norms.

4. A. subdatasheet is a datasheet linked within another datasheet 
containing related data.

5. Values in a Lookup field are always listed in ascending order.

6. Deleting the join line between two field lists in the Relationships 
window deletes the corresponding common fields in each of the two 
tables.

7. The Relationships window can display more than one relationship at 
a time.

8. Normalization is the process of restructuring a relational database 
for the purposes of organizing data efficiently, eliminating field 
redundancy, and improving data consistency.

Short Answer Questions
Write the correct answer in the space provided.

1. What graphic represents the relationship between two tables in the 
Relationships window?

2. How do you delete a relationship in the Relationships window?

3. When the common field is a primary key in one table, what does it 
become in the other table?

4. In a One-To-Many relationship with referential integrity, how can you 
identify the table on the “many” side of the relationship?
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Exercise 5-18
The IT director has noticed that a relationship needs to be created 
between the facilities and the facilities type tables. You are directed to 
create the relationship and document your work.

1. Open a database by following these steps:

a. Locate and open the Lesson 05 folder.

b. If you already have a copy of [your initials]-EcoMed-05, skip to 
step 1d.

c. Make a copy of EcoMed-05 and rename it [your initials]-
EcoMed-05.

d. Open and enable content for [your initials]-EcoMed-05.

Skills Review

AC-171LESSON 5 Managing Data Integrity

5. Referential integrity cannot be set for what type of relationship?

6. What type of Lookup field can store more than one value per record?

7. What analyzing tool provides recommendations for restructuring a 
relational database for the purposes of organizing data efficiently, 
eliminating field redundancy, and improving data consistency?

8. What is an association placed on an object that requires the existence of 
another object known as?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

1. The One-To-Many relationship is the most commonly used relationship 
in business databases. Why do you think this is true?

2. Multi-valued Lookup fields can be very useful for most types of data; 
however, some fields should not have more than one value. What type of 
examples can you think of that should never contain more than one value?
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2. Create a relationship by following these steps:

a. From the Database Tools tab, in the Relationships group, click 
Relationships .

b. From the Design tab, in the Tools group, click Clear Layout . 
Click Yes to clear the layout.

c. From the Design tab, in the Relationships group, click Show Table .

d. From the Show Table dialog box, double-click tblFacilities and tblFacType.

e. Click Close.

f. Resize the Field Lists so you can see every field.

g. From the tblFacilities field list, click and drag the FacType field to the 
FacType field in the tblFacType field list.

h. In the Edit Relationship dialog box, click Create.

3. Create a Relationship Report by following these steps:

a. From the Design tab, in the Tools group, click Relationship Report .

b. Save the report as rptRelFac-Type and click OK.

Assessment

- Right-click the rptRelFac-Type tab, and choose Close All.

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

-OR-

- Save a Relationship Report by following these steps:

 a. Click the File tab and from the Print option, click Print Preview .

 b.  From the Print Preview tab, in the Data group, click PDF or XPS  to 
save the printout as a file.

 c. Save the file as a PDF and name the file [your initials]-05-18-A.

 d. Depending on your class procedures, print or turn in the PDF file.

Exercise 5-19
Now that a relationship has been created between two tables, insert a 
subdatasheet into the facilities type table using the appropriate field as 
the link.

1. The database [your initials]-EcoMed-05 is required to complete this 
exercise.

a. Open and enable content for [your initials]-EcoMed-05.

05-18-A.pdf 
1 Page
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AC-173LESSON 5 Managing Data Integrity

2. Insert a subdatasheet by following these steps:

a. Open tblFacType in Datasheet View.

b. From the Home tab, in the Records group, click the More button  
and choose Subdatasheet, then Subdatasheet , from the menu.

c. From the list, select tblFacilities with the Child and Master fields 
FacType. Click OK.

d. Close the table and save the changes.

3. Set Enforce Referential Integrity by following these steps:

a. From the Database Tools tab, in the Relationships group, click 
Relationships .

b. Right-click the sloping part of the join line between tblFacilities 
and tblFacType, and choose Edit Relationship.

c. Click the check box to select Enforce Referential Integrity and click OK.

d. From the Quick Access toolbar, click Save .

e. Close the Relationship window.

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

-OR-

- Create a Database Documenter report by following these steps:

 a.  From the Database Tools tab, in the Analyze group, click Database 
Documenter .

 b. From the Documenter dialog box, click the tblFacType check box.

 c. Click Options.

 d. For Table, include Properties and Relationships.

 e. From the Include for Fields section, choose Nothing.

 f. From the Include for Indexes section, choose Nothing.

 g. Click OK twice to go to Print Preview.

- Save a Database Documenter report by following these steps:

 a.  From the Print Preview tab, in the Data group, click PDF or XPS  to 
save the printout as a file.

 b. Save the file as a PDF and name the file [your initials]-05-19-A.

 c. Depending on your class procedures, print or turn in the PDF file.

 d.  From the Print Preview tab, in the Close Preview group, click Close Print 
Preview .05-19-A.pdf 
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Exercise 5-20
The client facility information stored in the facilities table includes a 
field to identify the corresponding information for the client’s corporate 
(management) information. Create a Lookup field to allow a user to select 
the management location by the name of the company.

1. The database [your initials]-EcoMed-05 is required to complete this 
exercise.

a. Open and enable content for [your initials]-EcoMed-05.

2. Create a Lookup field by following these steps:

a. Open tblFacilities in Design View and select the field ManageID.

b. Click the down-arrow for the ManageID’s Data Type and select 
Lookup Wizard.

c. In the Lookup Wizard dialog box, click Next.

d. From the list of tables, select Table: tblManagement and click Next.

e. In the Available Fields area, double-click ManageID and ManageName. 
Click Next.

f. Click the drop-down arrow and choose ManageName. Click Next.

g. Resize the ManageName column so all data can be seen. Click Next.

h. Name the field Management. Click Finish.

i. Save the table and switch to Datasheet View.

j. Close the table.

3. Identify Object Dependency by following these steps:

a. Create a Word document called [your initials]-05-20-A and record 
the answers to the following questions.

b. Select tblFacilities.

c. From the Database Tools tab, in the Relationships group, click Object 
Dependencies .

d. Select Objects that depend on me. What objects depend on 
tblFacilities?

e. Select Objects that I depend on. What objects does tblFacilities 
depend on?

f. Include your name, class information, and today’s date on your 
answer sheet.

g. Close the Object Dependency pane.

05-20-A.pdf 
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AC-175LESSON 5 Managing Data Integrity

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

- Depending on your class procedures, print or turn in the Word file.

-OR-

- Create a Database Documenter report by following these steps:

 a.  From the Database Tools tab, in the Analyze group, click Database 
Documenter .

 b. From the Documenter dialog box, click tblFacilities check box.

 c. Click Options.

 d. For Table, include Properties and Relationships.

 e. For Fields, select the option Names, Data Types, and Sizes.

 f. For Indexes, select the option to Nothing.

 g. Click OK twice to go to Print Preview.

- Save a Database Documenter report by following these steps:

 a.  From the Print Preview tab, in the Data group, click PDF or XPS  to 
save the printout as a file.

 b. Save the file as a PDF and name the file [your initials]-05-20-B.

 c. Depending on your class procedures, print or turn in the PDF file.

 d. Close Print Preview.

- Depending on your class procedures, print or turn in the Word file.

Exercise 5-21
As you learned before, using the Table Analyze Wizard can help identify how 
best to change your table structure. Use the analyzer and make any 
appropriate changes to the database. Document any changes that you make.

1. The database [your initials]EcoMed-05 is required to complete this 
exercise.

a. Open and enable content for [your initials]-EcoMed-05.

2. Create a Lookup field by following these steps:

a. From the Database Tools tab, in the Analyze group, click the Analyze 
Table .

b. In the Table Analyze Wizard, click Next twice.

c. From the list of Tables, select tblFacilities. Click Next.

d. Verify that the option Yes, let wizard decide is selected. Click Next.

05-20-B.pdf 
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e. In Table3, click and drag the field FacType back into Table1 under the 
field FacName.

f. Double-click Table1 and name the table tblFac.

g. Double-click Table2 and name the table tblManageType. Click Next.

h. In the table tblFac, select the field FacilitiesID. In the upper right 
corner click the Primary key button . Click Next.

i. No corrections are needed. Click Next. Click Yes.

j. Verify that the option No, don’t create a query. Click Finish.

3. Rename a column in Datasheet View by following these steps:

a. Close the table tblManageType.

b. Open tblFac in Datasheet View.

c. Select the column header for the field Lookup to tblManageType.

d. From the Fields tab, in the Properties group, click Name & Caption .

e. Rename the Name to ManageTypeID and the Caption to Manage 
Type.

f. Save and close the table.

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

-OR-

- Create a Database Documenter report by following these steps:

 a.  From the Database Tools tab, in the Analyze group, click Database 
Documenter .

 b. From the Documenter dialog box, click tblFac check box.

 c. Click Options.

 d. For Table, include Properties and Relationships.

 e. For Fields, select the option Names, Data Types, and Sizes.

 f. For Indexes, select the option Nothing.

 g. Click OK twice to go to Print Preview.

- Save a Database Documenter report by following these steps:

 a.  From the Print Preview tab, in the Data group, click PDF or XPS  to 
save the printout as a file.

 b. Save the file as a PDF and name the file [your initials]-05-21-A.

 c. Depending on your class procedures, print or turn in the PDF file.

 d. Close Print Preview.05-21-A.pdf 
1 Page
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Exercise 5-22
EcoMed employees take days off from work as both vacation and sick 
days. To display the days taken when the employee uses leave, you will 
need to link the table storing the employee information to the table 
storing the leave days. Create a relationship and document any changes 
that you make.

1. Using the database, [your initials]-EcoMed-05, make sure that all 
content is enabled.

2. Open the Relationships window and clear the layout.

3. Add tblEmployees and tblLeaveDays to the window. Size the Field Lists 
so that all fields are visible, and identify the common field.

4. Create a One-To-Many relationship with referential integrity between 
the tables. Save and close the layout.

5. Create a Relationship Report for these two tables.

6. Save the report as rptRelEmpLeave.

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

-OR-

-  Save the Relationship Report as a PDF file named [your initials]-05-22-A.

- Depending on your class procedures, print or turn in the PDF file.

- Close Print Preview.

Exercise 5-23
Now that a relationship has been created between two tables, insert a 
subdatasheet into the employees table using the appropriate field as the 
link. After creating the subdatasheet, identify the dependencies for the table.

1. Using the database [your initials]-EcoMed-05, make sure that all 
content is enabled.

2. Open tblEmployees in Design View.

Lesson Applications
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3. Create a subdatasheet to tblLeaveDays.

4. Create a Word document called [your initials]-05-23-A and record 
the answers to the following questions:

5. What queries, forms, and reports depend on tblEmployees?

6. On what queries, forms, and reports does tblEmployees depend?

7. Include your name, class information, and date.

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

- According to your class procedures, print or turn in the Word file.

-OR-

-  Create a Database Documenter report for tblEmployees using the following 
settings:

• Include for Table: Properties, Relationships only

• Include for Fields: Nothing

• Include for Indexes: Nothing

- Save the Documenter report as a PDF file named [your initials]-05-23-B.

-  Depending on your class procedures, print or turn in the Word file 
[your initials]-05-23-A.

-  Depending on your class procedures, print or turn in the PDF file 
[your initials]-05-23-B.

Exercise 5-24
EcoMed employees are classified as either salaried or hourly employees. 
You have been directed to modify the pay table to have a Lookup field for 
these two pay classifications.

1. Using the database [your initials]-EcoMed-05, make sure that all 
content is enabled.

2. In tblPay, add a Lookup field to the end of the table.

3. In the Lookup wizard, you will type the values Hourly and Salary.

4. Limit entries to the list.

5. Name the new field PayType.

6. Do not allow users to edit the list.
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7. Change the PayType’s field size to 6.

8. The values in the field PayClass are “1” and “2.” The “1” represents 
salary, and the “2” represents hourly. Add values to the new field 
PayType. In each record where the PayClass is “1”, enter Salary for the 
PayType field. In each record where the PayClass is “2”, enter Hourly for 
the PayType field.

9. Delete the field PayClass and sort the table in ascending order by 
Employee ID.

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

-OR-

-  Create a Database Documenter report for tblPay using the following 
settings:

• Include for Table: None

• Include for Fields: Names, Data Types, Sizes, and Properties

• Include for Indexes: Nothing

- Save the Documenter report as a PDF file named [your initials]-05-24-A.

- According to your class procedures, print or turn in the PDF file.

-  Save the Datasheet View of tblPay in portrait layout as a PDF. Name the 
file [your initials]-05-24-B.

- According to your class procedures, print or turn in the PDF file.

Exercise 5-25  Challenge Yourself
As you learned before, using the Table Analyze Wizard can help identify 
how to best change your table structure. Use the analyzer on the 
employees table and make any appropriate changes to the database. 
Document any changes that you make.

1. Using the database [your initials]-EcoMed-05, make sure that all 
content is enabled.

2. Using the Table Analyzer Wizard, select tblEmployees but do not let the 
wizard decide which fields are to be used.

3. Create a new table named tblJobCodes by dragging the JobCode field 
out of Table1.
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4. Rename Table1 to tblEmp.

5. In tblEmp, rename the new Lookup field JobCodeID 
and its Caption Job Code.

6. In tblJobCodes, set the ID field’s Caption property to 
Job Code ID.

Assessment

-  According to your classroom procedure, turn in your database only when 
you have completed all assigned exercises.

-OR-

-  Create a Database Documenter report for tblEmp using the following 
settings:

• Include for Table: Properties, Relationships only

• Include for Fields: Names, Data Types and Sizes

• Include for Indexes: Nothing

- Save the Documenter report as a PDF file named [your initials]-05-25-A.

- According to your class procedures, print or turn in the PDF file.

TIP

The Wizard doesn’t always pick the field 
you want, so you can always drag the 
unwanted field back to the main table 

and drag out of the main table the field 
that you do want.

05-25-A.pdf 
1 Page

On Your Own

In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and 
be creative.

Exercise 5-26
Review the designs for the three databases you created in Exercises 4-29 
through 4-31. Select one of the three databases to continue developing. 
Identify two additional tables you might need to make your database designs 
more useful. The relationships between the main table and the two additional 
tables should be One-To-Many. On a blank sheet of paper, list the field names, 
data types, field sizes, and attributes for the two new tables. Identify the 
common fields among the three tables. Continue to Exercise 5-27.
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Exercise 5-27
Create the two tables you designed in Exercise 5-26. Add appropriate field 
properties to each table to make your design more useful. Create One-To-
Many relationships with referential integrity between the tables. Test the 
referential integrity of the tables. Add at least five records to each empty 
table. Print the datasheet and a database documenter report each table. 
Continue to Exercise 5-28.

Exercise 5-28
Search the Internet for images or graphics you might wish to use in your 
database. Design and create a new table to store the images. Create an 
appropriate relationship between this new table and the main table. Insert 
the images into the new table. Print a Relationship Report displaying all 
four tables. Submit to your instructor the printouts from Exercises 5-27 
through 5-28, along with your field list from 5-26. Keep a copy of the 
database you modified in this exercise. You will use it for the On Your Own 
exercises in subsequent lessons.
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